<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Indicates a hint. Is used to provide information on how to avoid operating errors or information emphasizing important details.</td>
</tr>
<tr>
<td>»</td>
<td>Indicates the solution of a problem. Is used to provide troubleshooting information or answers to frequently asked questions.</td>
</tr>
<tr>
<td>□</td>
<td>Indicates a list item.</td>
</tr>
<tr>
<td>✓</td>
<td>Indicates a prerequisite. Is used for a condition that has to be fulfilled before starting a particular operation.</td>
</tr>
<tr>
<td>◆</td>
<td>Indicates a one-step operation.</td>
</tr>
<tr>
<td>1 2 3</td>
<td>Indicates steps within operating sequences.</td>
</tr>
<tr>
<td>*</td>
<td>Italic. Is used for references and for table or figure titles.</td>
</tr>
<tr>
<td>➔</td>
<td>Is used to identify a link to related information as well as previous or next steps.</td>
</tr>
<tr>
<td>**</td>
<td>Bold. Is used to identify window titles, menu items, function names, buttons, and keys, for example, the Save button.</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue. Is used to emphasize particularly important sections of the text.</td>
</tr>
<tr>
<td>Courier</td>
<td>Courier. Is used for on-screen output of the system including code-related elements or commands.</td>
</tr>
<tr>
<td>Menu &gt; Menu Item</td>
<td>Is used for the navigation to a certain submenu entry.</td>
</tr>
<tr>
<td>&lt;variable&gt;</td>
<td>&lt;variable&gt;. Is used to identify variables or parameters, for example, within a string.</td>
</tr>
</tbody>
</table>

### CAUTION

Used with the safety alert symbol, indicates a hazardous situation which, if not avoided, could result in minor or moderate injury or material damage. CAUTION consists of the following elements:

- Information about the nature of a hazardous situation
- Consequences of not avoiding a hazardous situation
- Methods of avoiding a hazardous situation
WARNING
Indicates a hazardous situation which, if not avoided, could result in death or serious injury.
WARNING consists of the following elements:
- Information about the nature of a hazardous situation
- Consequences of not avoiding a hazardous situation
- Methods of avoiding a hazardous situation
# Table of contents

1 Introduction 11
   1.1 Layout of the operator manual 11
   1.2 The current operator manual 11
   1.3 Intended use 12
   1.4 Authorized operating personnel 13
      1.4.1 Definitions of different persons 13

2 Preparation 15
   2.1 Reducing motion artifacts 16
      2.1.1 Single excitation 16

3 Measurement 17
   3.1 Diffusion-weighted measurements 18
      3.1.1 General information 18
      3.1.2 Determining the ADC value (optional)
          Measuring diffusion-weighted images 18
          Evaluating the ADC map 20
   3.2 1H MR Spectroscopy of the breast with *syngo* GRACE 20
      3.2.1 General information 20
          Applications 21
          Quantification 21
      3.2.2 Quantifying the total choline in breast tumors 21
          Reformatting reference images 21
          Planning the VOI 22
          Suppressing interference signals 24
          Starting protocol adjustments (optional) 26
          Shimming interactively (optional) 27
          Improving shim results (optional) 29
          Adjusting the frequency (optional) 30
          Measuring raw data 31
          Measuring the external reference 32
## Table of contents

3.3 Prosthetic silicone implants

### 3.3.1 General information
- Spectral differences
- Types of visualization
- Helpful information from the patient

### 3.3.2 Displaying pure silicone images (optional)
- Suppressing the fat signal
- Suppressing the water signal
3.4 Breast Dot Engine
  3.4.1 Planning the examination and measuring the localizer
    Adapting the examination to the patient
    Selecting the examination strategy
    Auto Coverage
    Confirming frequency adjustments
    Auto Adjust Volume
    Defining the breast implant situation
    Measuring silicone images
    Performing multi planar reconstruction
    Accessing the Patient View
    Modifying parameters of measured protocols
    Starting the measurement of the localizer
  3.4.2 Defining the breast implant situation
    Confirming the resonance frequency
    Selecting the type and location of implants
  3.4.3 Imaging the morphology
  3.4.4 3D Examinations with integrated MPR planning
  3.4.5 Subsequent measurements
    Measuring diffusion-weighted images
  3.4.6 Measuring pure silicone images (optional)
  3.4.7 Displaying the biopsy coordinates
    Adapting the biopsy examination
    Planning the biopsy
  3.4.8 Configuring program steps (optional)
    Assigning 3D measurements to the integrated MPR post-processing
    Adding MPR views

4 Post-processing
  4.1 Spectroscopy evaluation
    4.1.1 Normalizing the choline signal
    4.1.2 Reviewing spectra
1 Introduction

In order to operate the MR system accurately and safely, the operating personnel must have the necessary expertise as well as knowledge of the complete operator manual. The operator manual must be read carefully prior to using the MR system.

1.1 Layout of the operator manual

Your complete operator manual is split up into several volumes to improve readability. Each of these individual operator manuals covers a specific topic:

- Hardware components (system, coils, etc.)
- Software (measurement, evaluation, etc.)

Another element of the complete operator manual is the information provided for the system owner of the MR system.

The extent of the respective operator manual depends on the system configuration used and may vary.

All components of the complete operator manual may include safety information that needs to be adhered to.

The operator manuals for hardware and software address the authorized user. Basic knowledge in operating PCs and software is a prerequisite.

1.2 The current operator manual

This manual may include descriptions covering standard as well as optional hardware and software. Contact your Siemens Sales Organization with respect to the hardware and software available for your system. The description of an option does not infer a legal requirement to provide it.
The graphics, figures, and medical images used in this operator manual are examples only. The actual display and design of these may be slightly different on your system.

Male and female patients are referred to as “the patient” for the sake of simplicity.

1.3 Intended use

Your MAGNETOM MR system is indicated for use as a magnetic resonance diagnostic device (MRDD) that produces transverse, sagittal, coronal and oblique cross sectional images, spectroscopic images and/or spectra, and that displays the internal structure and/or function of the head, body, or extremities. Other physical parameters derived from the images and/or spectra may also be produced. Depending on the region of interest, contrast agents may be used. These images and/or spectra and the physical parameters derived from the images and/or spectra when interpreted by a trained physician yield information that may assist in diagnosis.

Your MAGNETOM MR system may also be used for imaging during interventional procedures when performed with MR compatible devices such as in-room displays and MR Safe biopsy needles.

- The MAGNETOM MR system is not a device with measuring function as defined in the Medical Device Directive (MDD). Quantitative measured values obtained are for informational purposes and cannot be used as the only basis for diagnosis.
- For the USA only: Federal law restricts this device to sale, distribution and use by or on the order of a physician.
- Your MR system is a medical device for human use only!
1.4 Authorized operating personnel

The MAGNETOM MR system must be operated according to the intended use and only by qualified persons with the necessary knowledge in accordance with country-specific regulations, e.g. physicians, trained radiological technicians or technologists, subsequent to the necessary user training.

This user training must include basics in MR technology as well as safe handling of MR systems. The user must be familiar with potential hazard and safety guidelines the same way the user is familiar with emergency and rescue scenarios. In addition, the user has to have read and understood the contents of the operator manual.

Please contact Siemens Service for more information on available training options and suggested duration and frequency of such training.

1.4.1 Definitions of different persons

<table>
<thead>
<tr>
<th>Term used</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Operator/Operating personnel</td>
<td>Person who operates the system or software, takes care of the patient or reads images</td>
</tr>
<tr>
<td></td>
<td>Typically physicians, trained radiological technicians, or technologists</td>
</tr>
<tr>
<td>System owner</td>
<td>Person who is responsible for the MR environment. This includes legal requirements, emergency plans, employee information and qualifications, as well as maintenance/repair.</td>
</tr>
<tr>
<td>MR worker</td>
<td>Person who works within the controlled access area or MR environment</td>
</tr>
<tr>
<td></td>
<td>User/Operator as well as further personnel (for example, cleaning staff, facility manager, service personnel)</td>
</tr>
</tbody>
</table>
1 Introduction

<table>
<thead>
<tr>
<th>Term used</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siemens Service/service personnel</td>
<td>Group of specially trained persons who are authorized by Siemens to perform certain maintenance activities</td>
</tr>
<tr>
<td></td>
<td>References to “Siemens Service” include service personnel authorized by Siemens.</td>
</tr>
</tbody>
</table>
2 Preparation

2.1 Reducing motion artifacts
2.1 Reducing motion artifacts

1 Instruct the patient to hold completely still during the entire examination.

2 Instruct the patient to take shallow and gentle breaths during the measurements.

3 Choose appropriate measurement methods to reduce motion artifacts.

2.1.1 Single excitation

For breast measurements, a motion-insensitive single-excitation TSE DIXON sequence is provided. Measurements can be performed using breathhold and respiratory-triggering techniques.

◆ In order to reduce motion artifacts, enable Fast Dixon in the Contrast Common parameter card.
3 Measurement

3.1 Diffusion-weighted measurements 18
3.2 1H MR Spectroscopy of the breast with syngo GRACE 20
3.3 Prosthetic silicone implants 33
3.4 Breast Dot Engine 40
3.1 Diffusion-weighted measurements

3.1.1 General information

The specificity of breast MRI can be increased using diffusion-weighted imaging (DWI).

**Principle of DWI:** DW MRI is based on the principle that random motion of molecules during the interval of excitation and signal measurement reduces the amplitude of the resulting signal. The application of appropriate pulse sequences (using, for example, bipolar gradient pulses in one or several directions) allows you to measure signal cancellation due to diffusion in the given direction. While normal tissue exhibits gross signal loss, areas with restricted molecular motion such as densely packed tumor cells show less signal loss and become bright in diffusion-weighted images.

**ADC map:** The ADC map (ADC = Apparent Diffusion Coefficient) allows for an in-vivo pseudo quantification of the diffusion effect. Due to the limited mobility of water molecules in the vicinity of a tumor, malignant lesions may show lower ADC values than benign lesions.

3.1.2 Determining the ADC value (optional)

First, you have to locate the lesion in the diffusion-weighted images. As a second step, you determine the ADC value in the corresponding ADC map.

**Measuring diffusion-weighted images**

✅ Localizer has been measured

✅ High-resolution protocol has been measured

✅ Diffusion-weighted protocol has been opened

1. Open the **Diff Body** parameter card.
2 Select the diffusion mode **3-Scan Trace**.

The measurements are performed in three random directions. 3 measurements per image are required.

3 Select the **b-value** (e.g. 50, 400, 800) and the number of **Averages** for each diffusion weighting.

Higher b-values extend the TE.

4 Select **Trace-weighted images** and **ADC maps**.

The number of diffusion directions is automatically set to 3.

**Performing the measurement**

- Start the measurement.

One diffusion-weighted image per slice position and b-value is calculated. The corresponding ADC maps are calculated automatically.
Evaluating the ADC map

✓ Diffusion-weighted images have been measured
✓ ADC maps are available

1 Transfer the diffusion-weighted images and the ADC maps to the Viewing task card.

2 Locate the lesion in the diffusion-weighted images and in parallel on a subtracted series.

3 Draw a region of interest (ROI) in the center of the lesion.

A central necrosis should not be enclosed by an ROI. It has a different cellularity and therefore a different ADC value compared to the tumor.

4 Copy the ROI to the ADC map.

5 Determine the ADC value (mean value of the greyscale values).

3.2 1H MR Spectroscopy of the breast with *syngo* GRACE

3.2.1 General information

The metabolite status in the tumor tissue can be acquired via the total choline (tCho) concentration. The concentration in healthy breast tissue is usually very low. An increased signal of total choline in the spectrum usually correlates with a positive biopsy result.

Please note: At higher field strength, small signals of total choline have also been detected in benign lesions and in normal breast tissue. Total choline levels may also be visible in the lactating breast along with the characteristic lactose signal.
Applications
- Help in the differentiation between tumors
- Monitoring the course of therapy
- Identification of possibly vital residual findings after chemotherapy and preoperative intervention

Quantification
To evaluate total choline as a metabolic marker, the metabolite has to be quantified.

Quantification with an external reference: A reference solution is present in the breast coil housing for quantifying the signal of total choline. The signal is automatically normalized with an additional measurement of the reference sample water signal.

Quantification with an internal reference: The signal of total choline can also be quantified by using an internal reference measurement, that is, in the tumor itself. For this purpose, you can perform a fast, non-water suppressed measurement in the tumor of identical voxel position and size.

The internal reference method is not considered clinically sound for controlling the course of therapy. For example during chemotherapy, the behavior of internal water in the tumor is largely unknown.

3.2.2 Quantifying the total choline in breast tumors

Reformatting reference images
- 3D subtraction data set is available
- SVS breast measurement program has been selected

When performing MRS after a routine imaging examination, you can use existing images as reference images to plan the MRS measurement.
To plan spectroscopy and for post-processing you need non-distortion corrected images (ND) in the three main orientations. Spectroscopy measurements must be performed at the same table position as the ND images used for planning.

1. Use, for example, thin MIP reconstruction to reformat the 3D subtraction data set into 3 orthogonal planes centered on the lesion.

2. Save the new MIP series.

3. Load the MIP series as reference images into the image area of the Exam task card.

Planning the VOI

An essential prerequisite for MR spectroscopy is a reliable localization. For MRS of the breast, you use the SVS technique (Single Voxel Spectroscopy) to allocate the spectra signals to the anatomic volume given. During SVS, only a limited volume of interest (VOI) is acquired. A single spectrum is obtained.

✓ SVS breast protocol has been opened

✓ VOI is displayed

1. Ensure, that the appropriate coil element for the measurement is selected.

2. Position the voxel so that it contains the tumor only.
Good planning.
Poor planning, voxel is too large (fat signal is superimposed on choline signal).

To better adjust the voxel to the lesion, you can position up to 8 saturation slices.

Suppressing interference signals

Suppressing respiratory artifacts

To minimize artifacts caused by the patient's breathing, you perform an Inline frequency correction.

1 Open the **Sequence Common** parameter card.
2 Activate the **Freq. corr. accumulation** checkbox.

The system automatically activates a weak water suppression (**Contrast Common** parameter card).

### Setting weak water suppression

A weak water suppression leaves a residual water peak. This allows you to include the water line in various post-processing functions.

- In the **Contrast Common** parameter card: Ensure that reduced water suppression has been selected.

### Suppressing fat signals

To minimize fat signals, you perform an Inline spectral fat saturation.

1 Open the **Contrast Common** parameter card.
2 Select Lipid suppr. from the Spectral suppr. list.

3 Select the bandwidth of the suppression pulse (Lipid suppr. BW).

4 Select the spectral shift of the suppression pulse (Lipid s. delta pos.).

Starting protocol adjustments (optional)

Semi-automatic adjustments are recommended for difficult anatomical regions (e.g. flow, vessels, jumps in susceptibility). You can check the shim status prior to the spectroscopy measurement and improve it, if necessary.

✓ Automatic adjustment is not satisfactory

1 Select Options > Adjustments from the main menu.

   The Manual Adjustments dialog window is opened.

2 Select the Show subtask card.
3 Start the adjustments with **Adjust All**.

All protocol adjustments are performed (as displayed in the information window).

**Shimming interactively (optional)**

The shim quality is particularly important for spectroscopy examinations. Use interactive shimming for checking and improving the examination. By changing the shim currents you are able to optimize the results (FWHM, T2*).

✓ Protocol adjustment has ended

1 In the **Manual Adjustments** dialog window: Select the **Interactive Shim** subtask card.
2 Start the shim with **Measure**.

An infinite measurement is performed with the currently set shim parameters.

3 Monitor the results for FWHM and T2*.

<table>
<thead>
<tr>
<th>FWHM [Hz]: as small as possible</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 T &lt; 25 Hz</td>
</tr>
<tr>
<td>3 T &lt; 30 Hz</td>
</tr>
</tbody>
</table>

| T2*: as large as possible. Depends on voxel size and the metabolites contained within. |
4 End the measurement with **Stop** as soon as you are satisfied with the results. (Otherwise: (→ Page 29 *Improving shim results (optional)*).

During visual inspection: If the water is less than twice the fat amplitude, the size and/or position of the voxel should be readjusted.

5 Apply the shim results to the following spectroscopy measurement with **Apply**.

6 Close the dialog window.

7 Start the spectroscopy measurement.

**Improving shim results (optional)**

If the results for FWHM and T2* are not satisfactory, you can improve the homogeneity of the magnetic field by changing the shim currents.

- **Interactive Shim** subtask card has been opened
- Shim results are not satisfactory
- Change the gradient offset for **one** shim channel.

**Example Channel X**

1 Increase the value with the **up** arrow button.

2 Monitor FWHM and T2*.
   
   If the result worsens:

3 Use the best shim results of the current measurement with **Load Best**.

4 Change the gradient offset in the other direction (use the **down** arrow button).
   
   If the results for FWHM and T2* continue to be unsatisfactory:

5 Repeat the steps for the other channels (Y, Z).

   As soon as you are satisfied with the results:

6 End the measurement with **Stop**.

7 Apply the shim results to the following spectroscopy measurement with **Apply**.
Adjusting the frequency (optional)

Whenever you change shim currents, a “?” appears in the **Frequency (syst)** field. This means that the frequency still needs to be adjusted (if not performed manually, the system handles it automatically).

✓ Shim currents have been changed

1 In the **Manual Adjustments** dialog window: Select the **Frequency** subtask card.

2 Start the frequency adjustment with **Go**.

3 Monitor the tolerance parameter “Diff [Hz]”.

Optimal frequency: Diff [Hz] = 0 +/- 2 Hz

4 Repeat the adjustment until you obtain a satisfactory value for “Diff [Hz]” and the “Y” in the A. column appears.

5 Transfer the frequency determined to the measurement system with Close.

You can now begin with the spectroscopy measurement.

Measuring raw data

You are starting to generate the spectroscopy raw data. During the measurement, you are able to monitor the raw signal in the Inline Display and control the measurement accordingly.

✓ VOI has been planned

1 Start the measurement.

All adjustments required are performed automatically prior to the measurement. For most applications, the default values of the adjustment configuration that have been currently determined are considered optimal. (Otherwise: (Page 26 Starting protocol adjustments (optional)).)

2 To open the Inline Display, select View > Inline Display from the main menu.
After the measurement, the spectroscopy raw data and the reference images are automatically stored to the patient database (as shown by the icons).

Icons for reference images and spectroscopy raw data in the Patient Browser.

Follow-up examinations: Use the Phoenix functionality of the syngo software to recall the same measurement protocol. This ensures that the same parameters are used for all measurements except the voxel size, which may be adjusted to the reduced size of the tumor.

Measuring the external reference

1. Open and start the reference localizer (localizer_ref). The localizer is already positioned on the small reference bottle.

2. Open the svs_se_breast_ref reference protocol.
3 Position the voxel fully within the reference solution.

4 Start the SVS reference measurement.
   A fast SVS measurement without water suppression is performed.
   For a description of measuring the internal reference, please refer to: (➔ Page 21 Quantification).
   For a description of evaluating spectra, please refer to: (➔ Page 58 Spectroscopy evaluation).

3.3 Prosthetic silicone implants

3.3.1 General information
   MR imaging of prosthetic silicone implants requires high-resolution images. Depending on the clinical question, either fat or silicone can be suppressed, or pure silicone images can be created.

Spectral differences
   Spectral differences between fat, silicone, and normal breast parenchyma enable selective signal suppression.
Display of MR spectra: The frequency of spectra (silicone, fat, and water) runs from left to right. Normally, the fat line somewhat overlays the silicone line.

1. Amplitude
2. Frequency
3. Silicone
4. Fat
5. Water

**Fat/silicone suppression:** Fat or silicone suppression may be complete or partial, for example, by changing the inversion recovery time in a STIR protocol.

**Better orientation:** The contours of the breast and implants may be improved using a partial fat/silicone suppression.

**Types of visualization**

**Pure silicone images:** To display capsule contractures, prosthesis dislocation, ruptures (intracapsular: “linguini” signs, extracapsular: defect in the fibrous capsule, possibly siliconoma).
With silicone suppression: To display fat or tumors.

With water suppression: To suppress the signal from cysts (water is displayed dark).

With fat suppression: To display water-filled cysts (water is displayed bright).
Helpful information from the patient
- Age and type of implants.
- Whether it is the first implant in the breast.
- Whether prior implants were ruptured.
- Amount of saline solution added and how it was added.

3.3.2 Displaying pure silicone images (optional)
It may be necessary to display silicone implants during breast examinations. In this case, the signals from fat and water have to be suppressed. The result image displays the pure silicone signal.

Sample measurement program
- STIR with water saturation: The fat signal is suppressed by an additional inversion pulse. The water saturation pulse (centered on the water peak) suppresses the signal from the breast and blood vessels. In the result image, silicone is displayed bright.

Spectral water saturation is possible because the frequency separation between water and silicone is greater than that between water and fat. However, silicone may become partially saturated.

- T2 sagittal: To check the impermeability of the silicone implant. Displays creases in the implant (e.g. linguini or keyhole signs)

Silicone suppression: With any T1-weighted or T2-weighted measurement using a water saturation pulse (centered on the silicone peak). In the result image, silicone is displayed dark.

Suppressing the fat signal
- ✓ Coil element has been selected
- ✓ Localizer has been measured
- ✓ Protocol has been opened
- ✓ Slices have been positioned
An inline adjustment is performed automatically prior to each measurement. You can pause the system to confirm or change the resonance frequency calculated by the adjustment.

1. Open the **System Adjustments** parameter card.

2. Activate the **Confirm freq. adjustment** and **Assume Silicone** checkboxes.

3. Start the measurement.

   The adjustment is performed automatically. The **Confirm Frequency Adjustment** dialog window is displayed.
For unilateral or small implants: Check the automatic peak detection, because the silicone signal can be very small. For this purpose, view the signals of the individual coil elements. They allow you to check whether the system frequency on the side of the implant is located on the desired peak (e.g. on the water peak, if water is to be saturated to obtain a silicone image).

4 If you want to accept the requested frequency without changes to it, click **Continue**.

The measurement is performed without additional adjustments.

**Changing the resonance frequency**

Changing the resonance frequency might be necessary, when system frequency is not set on the water peak.

1 Enlarge the frequency spectrum by double-clicking with the right mouse button.
2 Center the frequency on the fat peak by clicking the fat peak.

The new transmit frequency is copied to the **Frequency (temp)** field.

3 Add 220 Hz at 1.5 T to this value or 440 Hz at 3 T (the last 3 numbers of the transmit frequency).

4 Accept the new frequency with **Apply**.

5 Start the measurement with **Continue**.

The measurement is performed without additional adjustments.

---

### With very high fat proportions: Check the automatic peak detection prior to each measurement with spectral fat sat and adjust manually, if necessary.

#### Suppressing the water signal

The water saturation suppresses the peak used for centering the resonance frequency and may be utilized for almost every protocol.

- ✓ Coil element has been selected
- ✓ Localizer has been measured
- ✓ Protocol has been opened
- ✓ Slices have been positioned

#### Setting the water suppression

1 Open the **Contrast Common** parameter card.
2 Set the water suppression to **Water sat**.

### 3.4 Breast Dot Engine

The **Breast Dot Engine** covers the main use case of breast MRI, which is lesion evaluation. Multiple variants, such as lesion evaluation with or without implants (which can be silicone or saline) are provided.

For improvement of the biopsy workflow, a biopsy support is provided. (→ Page 49 **Displaying the biopsy coordinates**)

---

The Dot Engine user interfaces shown in this operator manual are examples only. The actual guidance texts and the design may be slightly different on your system.

In the following, we are focusing on examinations with the 16-Channel AI Breast Coil.
3.4.1 Planning the examination and measuring the localizer

- Patient has been registered
- 16-Channel AI Breast Coil has been connected
- Coil elements have been selected
- **Breast Dot Engine** has been selected

Adapting the examination to the patient

After registration, the **Patient View** opens automatically. The default examination parameters are loaded.

In the **Patient View** you adapt the examination parameters to the patient’s need. The pending protocols of the measurement queue are updated upon your selection.

**Selecting the examination strategy**

Standard scans consist of a pre-contrast scan with multiple post-contrast phases followed by a high-resolution morphological scan. INTERVIEWS consist of a pre-contrast scan with two initial post-contrast phases, followed by a high-resolution morphological scan and ending with a final post-contrast dynamic phase.

The following examination strategies can be selected:
Fatsat Standard/Non Fatsat Standard
Fatsat INTERVIEWS/Non Fatsat INTERVIEWS

◆ From the list: Select a suitable Exam Strategy for the patient.

Auto Coverage

◆ Select the Auto Coverage checkbox if the FoV calculation and slice positioning should be performed automatically.

Confirming frequency adjustments

◆ Select the settings for the adjustment of the resonance frequency.

<table>
<thead>
<tr>
<th>Confirm freq. adjustment</th>
<th>Activates the corresponding checkbox on the System Adjustments parameter card.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only after frequency change</td>
<td>Activates the corresponding checkbox on the System Adjustments parameter card. For example, a frequency change usually occurs when the adjust volume or the position has been changed.</td>
</tr>
</tbody>
</table>

Auto Adjust Volume

◆ Select the Auto Adjust Volume checkbox if the adjust volume should be performed automatically.

In combination with TimTX TrueShape, the additional parameter Auto pTx Volume can be selected.

Defining the breast implant situation

◆ Select yes in the Implant Type Confirmation dropdown menu if the type of implants is not known. Otherwise, you can select no from the list.

Program steps for defining the implants will be added to the measurement queue. (→ Page 44 Defining the breast implant situation)

Measuring silicone images

◆ Select yes in the Additional Silicone Protocols dropdown menu if you want to display silicone implants. (→ Page 48 Measuring pure silicone images (optional))
Performing multi planar reconstruction

◆ Select yes the Inline MPR dropdown menu if you want to perform inline MPR post-processing for one or multiple 3D measurements.

(→ Page 47 3D Examinations with integrated MPR planning)

Accessing the Patient View

You can access the Patient View at any time during the examination.

1 To open the view, click the icon.

2 To confirm the settings and close the view, click the icon.

Modifying parameters of measured protocols

Changes in the Patient View only apply to pending protocols in the measurement queue.

1 To change the status of a protocol from measured to pending, select the measured protocol.

2 Select Rerun from here from the context menu (right-click with the mouse)

3 Open the Patient View.

or

4 Select Rerun from here with from the context menu (right-click with the mouse).

The Patient View opens automatically.

5 Enter the requested modifications.

Starting the measurement of the localizer

◆ Confirm the patient-specific settings.

The sagittal, coronal and transverse localizers are measured and displayed.

If you have selected the Implant Type Confirmation from the list, the implant type scan is performed first, followed by the Breast Implant Situation View for defining the type and location of implants.
3.4.2 Defining the breast implant situation

The parameters for the subsequent measurements depend on the implant type.

Confirming the resonance frequency

✓ Localizer has been measured

✓ **Implant type scan** has been started

At the beginning of the **Implant type scan** the **Confirm Frequency Adjustment** dialog window is displayed.

1. Note the displayed frequency spectrum for the next step.
2. Remember the position of system frequency (dotted line): on the water peak, or to the right of the water peak.
3. Accept the frequency with **Continue**.

Selecting the type and location of implants

✓ Implant type scan has been performed

✓ **Breast Implant Situation View** has opened

◆ Select the type of implant (**None**, **Silicone** or **Saline**), and the location of the implant (left, right, or both breasts).
Example: Two silicone implants

Depending on the selections in the Breast Implant Situation card, the frequency adjustment setting (assume dominant fat/assume silicone) of the protocols will be changed.

If you select None or Saline for both sides:

- the protocols will be adapted automatically to Assume Dominant Fat.

If you select Silicone for both sides:

- the protocols will be adapted automatically to Assume Silicone.

If you select Silicone for one side:

- unilateral scans will be adapted to Assume Silicone.
- if the system frequency is on water peak, bilateral scans are adapted to Assume Silicone.
- if the system frequency is right of water peak, bilateral scans are adapted to Assume Dominant Fat.

After you have finished the definition of the breast implant type situation, a 3D morphological protocol opens.
3.4.3 Imaging the morphology

✓ Localizer images are displayed
✓ 3D morphological protocol has opened

Within this step, you can define the FoV and the slice position for all subsequent measurements.

In the GSP segments, the system makes a proposal for the FoV and the slice positioning.

If Auto Adjust Volume has been selected, a proposal for the adjust volume is shown in green.

Example: Guidance image

1 Check the FoV, slice position and/or adjust volume in the GSP segments and adapt them, if necessary.
   In combination with TimTX TrueShape, check the pTx Volume.

2 If necessary, select the Parameters View to adapt additional settings for the measurements.

3 Start the measurement.
   The result images are displayed in the GSP.
### 3.4.4 3D Examinations with integrated MPR planning

The **Breast Dot Engine** provides an integrated planning step for MPR post-processing. MPRs of one or multiple 3D measurements are calculated immediately after each assigned measurement if they have been assigned beforehand.

MPR assignment is defined via the Dot Add-In, please refer to (→ Page 51 Configuring program steps (optional)).

✓ The MPR planning step has opened

![Parameters View for sagittal MPR planning](image)

**Example: Parameters View for sagittal MPR planning**

1. Select the desired MPR view from the list on the left side of the **Parameters View**.
   
   The corresponding MPR slice positions and orientations are displayed in the GSP segments.

2. Adapt the slice positioning, if necessary.

   In the **Parameters View**: You can also modify the view parameters alpha-numerically, for example the FoV.

3. Repeat the above steps for all MPR views.

4. Save the MPR settings.
As soon as the assigned 3D measurements have been concluded, the reconstruction of the MPRs is started automatically. For each assigned 3D measurement, the defined MPR views are generated.

The names of the resulting image series are a combination of the protocol name and the MPR view.

If you repeat an assigned 3D measurement, a new set of MPRs is calculated.

You may use the resulting MPR views for the slice planning of subsequent measurements.

### 3.4.5 Subsequent measurements

After the initial measurements, the following measurements are performed:

- T1-weighted high-resolution measurement (delayed view)
- Diffusion-weighted measurement
- T2-weighted bilateral measurement
- Final dynamic INTERVIEWS phase

**Measuring diffusion-weighted images**

For a detailed description, please refer to: (→ Page 18 Determining the ADC value (optional))

- **Auto Coverage** checkbox has been selected
- Position the FoV and the saturation band very exactly.

### 3.4.6 Measuring pure silicone images (optional)

To display silicone implants during breast examinations, the signals from fat and water have to be suppressed. The result image displays the pure silicone signal.
As measurement technique, Turbo inversion recovery magnitude (TIRM) with water saturation is used. The fat signal is suppressed by an additional inversion pulse. The water saturation pulse (centered on the water peak) suppresses the signal from the breast and blood vessels. For a detailed description, please refer to: (→ Page 36 Displaying pure silicone images (optional))

1 In the Patient View: Select the additional silicone protocols checkbox.

Three TIRM protocols with fat and water suppression are added to the queue.

2 Start the measurement.

In the result image, silicone is displayed bright.

### 3.4.7 Displaying the biopsy coordinates

The biopsy coordinates that are calculated using the *syngo Breast Biopsy* software or the *BreVis Biopsy* task card can be displayed on the Dot display of the MR system. You can activate the display of the coordinates from within the biopsy measurement by using the *Breast Step* Dot Add-in.

The coordinates are only valid until the next measurement is performed.

The available biopsy software depends on the connected coil. In the following, we are focusing on examinations with the 4-Channel BI Breast Coil and the *syngo Breast Biopsy* software.

Adapting the biopsy examination

1 Select the biopsy support.
2 Select **Left** or **Right Breast** in the **Exam Strategy** list.

3 Select **Access direction**, **Positioning Method** and **Software**.

- **syngo** Breast Biopsy software only supports Post&Pillar.

4 If you want to change the other settings, please follow the descriptions on the referenced page. (→ Page 41 *Planning the examination and measuring the localizer*).

5 Start the measurement.

   The dynamic measurements are performed. The **Guidance View** for biopsy planning opens.

**Planning the biopsy**

1 Open the planning step.

- If you plan an intervention outside the magnet, activate the **Table Lock** function to avoid accidental patient table movement, or injury to the patient. After completing the intervention, the table can be unlocked.
2 Plan the biopsy by selecting **Tools > Breast Biopsy** from the main menu.

The calculated biopsy coordinates are displayed on the Dot display of the MR system.

3 Insert the trocar and replace with the obturator.

4 Confirm biopsy coordinates with the obturator check scan.

5 Perform the biopsy.

6 Start the control measurement.

### 3.4.8 Configuring program steps (optional)

**Dot Engine Step:** The **Dot Engine Step** defines which strategies, decisions (patient context decisions or clinical decisions) and global parameters are valid for the complete Dot Engine workflow examination. (For a detailed description, please refer to: Operator Manual - Dot Cockpit.)

**Dot Add-Ins:** The **Dot Add-Ins** are predefined add-ins for **Dot Engine Steps** and program steps. Depending on the selected **Dot Add-In**, you can configure different parameters of the **Dot Engine Step**.
Assigning 3D measurements to the integrated MPR post-processing

In the Dot Add-In Configurator, you can define which planes are to be reformatted. In the MPR Planning step, you can define how the reformatting is performed.

✓ Dot Cockpit has been selected
✓ 3D protocol has been dragged into the Program Editor

For a detailed description, please refer to: Operator Manual - Dot Cockpit.

1 In the Program Editor create an interaction step.
2 Drag the MPR Planning Add-In from the Default Add-Ins sidebar on to the interaction step.
3 Drag a Breast Basic Dot Add-In from the Default Add-Ins sidebar on to the 3D protocol.
4 Open the Step Properties dialog window by double-clicking the protocol.
5 Click Add-In Configuration.
6 Select the MPR Assignment card and activate the desired checkboxes.
Adding MPR views

Using the MPR Planning Add-In, you can add new MPR views.

1  In the Program Editor: Select the interaction step with the MPR Planning Add-In.

2  Open the Step Properties dialog window by double-clicking the step.

3  Click AddIn Configuration.

4  Select the MPR Planning card.
5 Add the MPR view by clicking **Add MPR range**.

A new default MPR view is added to the list of available views.

**Renaming views**  
1 Right-click the added view with the mouse.

2 From the context menu: Select **Rename**.

3 Enter the new name.
4 Set the **Guidance** and **Parameter Views**. (Refer to Operator Manual - Dot Cockpit.)

**Removing views**

1. Right-click the view with the mouse.
2. From the context menu: Select **Remove**.
4 Post-processing

4.1 Spectroscopy evaluation
4.1 Spectroscopy evaluation

4.1.1 Normalizing the choline signal

✓ $^1$H MRS raw data is available
✓ Reference data set is available

Using normalization, the choline signal can be calibrated to a relative, standardized value. For this purpose, the ratio of the choline signal to the integral of the reference signal is computed. Normalized integral and amplitude values are displayed as $I^*$ and $A^*$, respectively.

1 Select Applications > Spectroscopy.

The Spectroscopy task card opens.

2 Select the raw data in the Patient Browser and load them to the Spectroscopy task card.

A post-processing protocol is applied automatically.

3 Click this icon.

4 Select the Normalization to reference post-processing step.

![Post-processing interface](image)
5 Activate **Find and load automatically** to enable the automatic search for a reference data set.

6 Start normalization with **Apply**.

### 4.1.2 Reviewing spectra

- Evaluate the images in the **Spectroscopy** task card.

Examples of spectra

![Spectrum Image](image1.png)

Tumor spectrum of breast cancer before chemotherapy. Biopsy correlates with high choline signal in the spectrum.

![Spectrum Image](image2.png)

Tumor spectra in the second cycle (left) and in the fourth cycle (right) of chemotherapy.
A
ADC map 18
   Evaluating 20
ADC value 18

B
Biopsy target coordinates 49
   Displaying 49
Breast Dot Engine 40
   Breast implant situation 44
   Configuring program steps 51
   Confirming the resonance frequency 44
   Diffusion-weighted imaging 48
   Imaging the morphology 46
   Measuring the localizer 43
   MPR planning 47
   Patient View 41
   Silicone images 48
   Subsequent measurements 48
   Type and location of implants 44
Breast implant situation
   Breast Dot Engine 44

C
Choline signal 58

D
Diffusion-weighted imaging 18
   ADC map 18
   Determining the ADC value 18
   Evaluating the ADC map 20
   Performing the measurement 18
   Principle 18
   Setting parameters 18
Dot add-in
   MPR Assignment 52
   MPR Planning 53
DWI
   Refer to Diffusion-weighted imaging 18

E
External reference

Spectroscopy 32

F
Fat signal
   Silicone implants 36
Fat signals
   Spectroscopy 25
Frequency
   Spectroscopy 30

I
Imaging the morphology
   Breast Dot Engine 46
Implant location
   Breast Dot Engine 44
Implant type
   Breast Dot Engine 44
Interactive shim
   Spectroscopy 27
Interference signals
   Spectroscopy 24

L
Localizer
   Breast Dot Engine 43

M
Motion artifacts
   Reducing 16
MPR planning
   Breast Dot Engine 47

N
Normalizing 58

P
Parameters
   Diffusion-weighted imaging 18
Patient View
   Breast Dot Engine 41
Program steps (Dot Engine)
   Configuration 51

Protocol adjustments
   Spectroscopy 26

R
Raw data
   Spectroscopy 31
Reference images
   Spectroscopy 21
Resonance frequency
   Breast Dot Engine 44
   Silicone implants 37, 38
Respiratory artifacts
   Spectroscopy 24

S
Shim results
   Spectroscopy 29
Shimming
   Interactively 27
Silicone images 36
   Breast Dot Engine 48
Silicone implants
   Adjusting the resonance frequency 37
   Changing the resonance frequency 38
   General information 33
   Image examples 34
   Setting the water suppression 39
   Spectral differences 33
   Suppressing the fat signal 36
   Suppressing the water signal 39
Spectra examples 59
Spectral differences
   Silicone implants 33
Spectroscopy
   Adjusting the frequency 30
   Applications 21
   General information 20
   Improving shim results 29
   Measuring raw data 31
   Measuring the external reference 32
   Planning the VOI 22
Quantification 21
Quantifying total choline 21
Reformatting reference images 21
Setting weak water suppression 25
Shimming interactively 27
Starting protocol adjustments 26
Suppressing fat signals 25
Suppressing interference signals 24
Suppressing respiratory artifacts 24
Spectroscopy evaluation 58
Examples of spectra 59
Normalizing the choline signal 58

T
Total choline
Quantifying 21

V
VOI
Spectroscopy 22

W
Water signal
Silicone implants 39
Water suppression
Silicone implants 39
Spectroscopy 25
Manufacturer’s note:

This product bears a CE marking in accordance with the provisions of regulation 93/42/EEC of June 14, 1993 for medical products.

The CE marking applies only to medico-technical products/medical products introduced in connection with the above-mentioned comprehensive EC regulation.

Global Business Unit
Siemens AG
Medical Solutions
Magnetic Resonance
Henkestr. 127
DE-91052 Erlangen
Germany
Phone: +49913184-0
www.siemens.com/healthcare

Global Siemens Headquarter
Siemens AG
Wittelsbacherplatz 2
80333 Muenchen
Germany

Global Siemens Healthcare Headquarter
Siemens AG
Healthcare Sector
Henkestraße 127
91052 Erlangen
Germany
Phone: +49 9131 84-0
www.siemens.com/healthcare

Legal Manufacturer
Siemens AG
Wittelsbacherplatz 2
DE-80333 Muenchen
Germany